
 
 
Sage Abra Suite v9.2 
Installation Guide 

April 2013 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is a publication of Sage Software, Inc. 

Document version: April 2013 

 

Copyright © 2013. Sage Software, Inc. All rights reserved. Sage, the Sage logos, and the Sage product and 
service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc. or its 
affiliated entities. All other trademarks are the property of their respective owners. Your use of this 
document and the Sage product(s) described herein is governed by the terms and conditions of the Sage 
End User License Agreement ("EULA") or other agreement that is provided with or included in the Sage 
product. Nothing in this document supplements, modifies or amends those terms and conditions. Except 
as expressly stated in those terms and conditions, the information in this document is provided by Sage 
"AS IS" and Sage disclaims all express, implied or statutory warranties of any kind, including but not 
limited to the warranties of merchantability, fitness for a particular purpose or of non-infringement. No 
implied license is granted to you under any Sage intellectual property or trade secret right. Sage reserves 
the right to revise, supplement, or remove information in this document at any time without notice to you 
or others. 

Sage End User License: http://na.sage.com/sage-na/eula 

http://na.sage.com/sage-na/eula


 

Installation Guide      1 

Table of Contents 
Overview ........................................................................................................................ 2 

Introduction ......................................................................................................................................................... 2 
Support and Documentation ............................................................................................................................. 2 

Install Sage Abra Suite for the First Time ...................................................................... 5 

Before You Begin ................................................................................................................................................. 5 
Install Sage Abra Suite ........................................................................................................................................ 5 

Step 1 - Install the Server ............................................................................................................................. 5 
Step 2 - Install the Clients ............................................................................................................................ 9 

Upgrade from v9.1 to v9.2 .......................................................................................... 13 

Read the following before you begin the upgrade ....................................................................................... 13 
Upgrading Live and Sample data ............................................................................................................ 13 
Installation requires installing server and client.................................................................................... 13 
If you are using Windows Terminal Services ........................................................................................ 13 

Upgrade to Sage Abra Suite v9.2 .................................................................................................................... 13 
Step 1 - Install the Server ........................................................................................................................... 13 
Step 2 - Install the Clients .......................................................................................................................... 16 

Upgrade from v9.0 to v9.2 .......................................................................................... 21 

Upgrading Live and Sample data ............................................................................................................ 21 
Installation requires installing server and client.................................................................................... 21 
If you are using Windows Terminal Services ........................................................................................ 21 
If you are using Windows Server 2008.................................................................................................... 21 

Upgrade to Sage Abra Suite v9.2 .................................................................................................................... 22 
Step 1 - Install the Server ........................................................................................................................... 22 
Step 2 - Install the Clients .......................................................................................................................... 27 

Sage Abra Suite Server ..................................................................................................................................... 33 
Sage Abra Suite Client ...................................................................................................................................... 34 

Printers ........................................................................................................................................................ 34 

Appendix ..................................................................................................................... 35 

How to re-register a new module, option, or link ........................................................................................ 35 
How to uninstall Sage Abra Suite v9.2 ........................................................................................................... 37 



 

To Uninstall Sage Abra Suite v9.2 ........................................................................................................... 37 
How to change servers after v9.2 has been installed ................................................................................... 38 
Learn about the new product installation ..................................................................................................... 38 

 

Overview 
Introduction 
This document includes instructions for installing Sage Abra Suite version 9.2 for the first time, as well as 
upgrading Sage Abra Suite v9.0 or v9.1 to version 9.2. 

Make sure you have the following items before you begin a new installation or an upgrade: 

• Version 9.2 Sage Abra Suite installation package 

• Sage Abra Suite 9.2 Installation Guide (this document) 

• Sage Abra Suite 9.2 Release Notes (to learn about the new features, enhancements, and 
modifications in version 9.2) 

Support and Documentation 
Sage strives to provide you with the very best support in the industry. If you have a question, we provide 
the following methods for you to get your answer as soon as possible: 

1. Read the Help menu or click  at the top of the window in Sage Abra Suite to open Help for the 
function you are currently using. 
 

2. Log on to the Sage Customer Portal at: https://customers.sagenorthamerica.com 

o Search for solutions to common problems 
o Download product updates 
o Read technical information 
o Open a support case 
o Create a service request 
o Grant your channel partner permission to view your support tickets 

3. Chat with a support analyst using Sage Live Chat, Monday through Friday from 9:00 A.M. to 5:00 
P.M. Eastern Time at: http://kb.sagesoftwareonline.com/app/chat/chat_launch 
 

https://customers.sagenorthamerica.com/
http://kb.sagesoftwareonline.com/app/chat/chat_launch
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4. Call Sage Abra Suite Support, Monday through Friday from 8:00 A.M. to 8:00 P.M. Eastern Time at 1-
800-829-0170. Please have your Customer ID handy when contacting Support. 
 

5. Call Sage Employer Solutions Customer Service, Monday through Friday from 8:30 A.M. to 5:30 P.M 
Eastern Time at 1-800-424-9392, or send an email to customerservice.employersolutions@sage.com.  

 

mailto:customerservice.employersolutions@sage.com
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Install Sage Abra Suite for the First Time 
This section steps you through installing Sage Abra Suite v9.2 for the first time. To familiarize yourself 
with the installation process, be sure to read through all the steps before you start the installation. 

Before You Begin 
• There are two required steps in the install process. You must first install the Sage Abra Suite 

(data) server and then install the Sage Abra Suite clients.  

• If your server is Windows Server 2008, Windows 7, or Windows Vista, you must reset the View 
properties on the C drive so that you can see the \ProgramData folder where the program files 
will reside after the installation. Open Windows Explorer and do the following: 

Go to Organize > Folder and Search Options. 

Click the View tab. 

Select the Show hidden files and folders button and click OK. 

• For security purposes, the server installation does not add an Everyone security group. This 
means that after the server installation, you must apply the appropriate permissions for the users 
who will be running the Sage Abra Suite application as well as accessing the data. These 
instructions are included in the steps to Install the Server. 

• If you are using Terminal Services in Windows Server 2008 or Windows Server 2003, after the 
Sage Abra Suite data server is installed on the terminal server, each person who will be running 
the Sage Abra Suite application must run the client installation. 

Install Sage Abra Suite 
The installation of Sage Abra Suite consists of two separate installations: installing on a server and 
installing on a client. Follow the steps below to first install Sage Abra Suite on a server, and then install a 
client either on the same server machine or on a separate client machine. If you will be running Sage Abra 
Suite on a network, each user must do a separate client install.  

Step 1 - Install the Server 

1. Close all Microsoft Windows applications. 



 

2. At the server machine, open the Sage Abra Suite installation package. Browse with Windows 
Explorer to the installation package folder and double-click setup.exe. The Sage Abra 
InstallShield Wizard dialog box opens. 

 

3. Click Install to open the Server Installation Welcome page. 

 

4. Click Next to begin the server installation. When the License Agreement dialog box opens, read 
or print the License Agreement, select I accept the terms in the license agreement, and click 
Next. 

5. Enter your Customer Information and click Next. 
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6. In the Destination Folder dialog box, click Next to install Sage Abra Suite Server in the default 
folder. Otherwise, click Change and select a different folder. 

Note: The following figure shows the default destination folder for Windows XP and 
Windows Server 2003. The default destination folder for Windows Server 2008, Windows 
Vista, and Windows 7 is C:\ProgramData\Sage\AbraSuite. 

 

7. Click Next to move to the Ready to Install the Program dialog box. 

 

8. You can review your settings by clicking Back through the previous screens. When you are sure 
your settings are correct, click Install. The progress bar appears during the installation. When the 
server installation is complete, click Finish. 



 

 

9. From Windows Explorer, go to the destination folder where you installed the server: 

• C:\Documents and Settings\All Users\Sage\AbraSuite if you are using Windows XP or 
Windows Server 2003 

• C:\ProgramData\Sage\AbraSuite if you are using Windows Server 2008, Windows Vista, or 
Windows 7 

10. Right-click the AbraSuite folder and select Sharing and Security to open the Abra Suite 
Properties dialog box. 

11. Click the Security tab and set the following permissions for each security group and/or user who 
will install the client and use Sage Abra Suite v9.2. Be advised that users who need access only to 
the data for reporting purposes also need these same permissions: 

• Modify 

• Read & Execute 

• List Folder contents 

• Read 

• Write 

12. Click the Advanced button on the Security tab, and for each permission entry, select the check 
box shown below so that the permissions are propagated all the way down to each folder and file 
inside the AbraSuite folder.  
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13. Click the Sharing tab and share the folder. Set the permissions for users who access this folder 
over the network on the shared folder to Full Control. (Right-click the AbraSuite folder, select 
Properties, select the Sharing tab, click Permissions, then set Full Control for the appropriate 
groups or users.) 

Note: Make sure that the folder’s Share Name does not contain a space. For example, in this 
figure, the default share name AbraSuite does not contain a space.  
 

 

Step 2 - Install the Clients 

Note: If you are using Terminal Services in Windows Server 2008 or Windows Server 2003, each 
person who will be running the Sage Abra Suite application must run the client installation. 

For each client machine that will access Sage Abra Suite, follow the steps below. Note that if you will 
run Sage Abra Suite on the server machine, you must also install a client on that server machine. 
When a new version is installed on the server, the clients will automatically update from the server.  

For each client machine, verify that there are no instances of a previous version of a Sage Abra Suite 
server or client installation. You can use the Add or Remove Programs control panel function to 
verify this. 

 Go to the shared folder on the server (either by using a UNC path or by creating a mapped drive) and 
from the Client folder, double-click setup.exe. If you are installing a client on the server machine, you 
can start the client installation using the shortcut Sage Abra Suite Client Install that was placed on 
the desktop during the server installation. 

The client installation begins and searches for the required components on your machine. 

 



 

Note: The first time the client is installed on each client machine, administrative rights are 
necessary to install these components and a dialog box will ask for an administrator user 
account and password. 

 Click Install to start installing the required components. When component installation is complete, 
you may be asked to restart your computer. If this is the case, restart immediately (not later). 

 When computer restart is complete, the client install will automatically continue. Note that the time it 
takes for the client install to start again depends on machine configuration and speed. If the client 
install does not continue after a significant amount of time and you have verified that your computer 
restart is complete, you can manually restart the client installation (go to the shared folder on the 
server and, from the Client folder, double-click setup.exe).The Application Install dialog box 
appears asking for final confirmation to install the client. 

 

 Click Install to install the Sage Abra Suite Client. The Installing Sage Abra Suite dialog box appears 
during installation. 
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 When installation is complete, the Register SageAbra Suite dialog box appears. Note that this opens 
only on the first client installation. 

 

 Enter the Serial Number and Installation Code you obtained from Sage Employer Solutions Customer 
Service. If you want to add a link or interface application, select the associated check box. 

 Click OK. 

Note: With Sage Abra Suite version 9.2, upon install of an update or upgrade, the system 
automatically updates your system tax tables with all available taxes. This feature applies 
strictly for your Live database. If you use the Sample database you will be required to 
manually apply the legislative updates in the System Tax Tables window after installation. 

 When registration is complete, the Sage Abra Suite Logon page opens. 

 



 

Note: The Use Windows Logon check box enables you to log on with your Windows user 
account. However, this logon method cannot be used until the proper user security 
authentication has been set for the user logging on. 

 Enter MASTER for Username and leave the Password blank. 

 Select one of the following options from the drop-down list: 

• Select Live Data to open Sage Abra Suite and begin setting up your employer’s data. 

• Select Sample Data to open Sage Abra Suite to look at a sample employer’s data. 

 Click Logon to open Sage Abra Suite. 

 Verify your upgrade was successfully installed by selecting Help > About Sage Abra Suite. 
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Upgrade from v9.1 to v9.2 
Tip: As a maintenance precaution, we recommend you do the following prior to installing your 
upgrade to version 9.2. 

• At the Logon Page, press Ctrl +U to update the database structures. 

• After the update database structures process completes, at the Logon page, press Ctrl + R to 
reform the indexes. 

 

This section steps you through upgrading your Sage Abra Suite v9.1 system to v9.2. 

Read the following before you begin the upgrade 

Upgrading Live and Sample data 

The upgrade process always overwrites existing Sample data with new Sample data. If you want to 
preserve your Sample data from v9.1, you will need to do an external backup before you do an 
upgrade and restore it after the upgrade. Live data is never overwritten on an upgrade. 

Installation requires installing server and client 

There are two required steps in the upgrade process. You must first install the v9.2 Sage Abra Suite 
(data) server and then install the v9.2 Sage Abra Suite clients. 

If you are using Windows Terminal Services 

If you are using Terminal Services in Windows Server 2008 or Windows Server 2003, after the v9.2 
Sage Abra Suite data server is installed on the terminal server, each person who will use the Sage 
Abra Suite application must run the v9.2 client installation. 

Upgrade to Sage Abra Suite v9.2 

Step 1 - Install the Server 

1. At the server machine, open the Sage Abra Suite installation package. Browse with Windows 
Explorer to the installation package folder, and then double-click setup.exe. 
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 The InstallShield Wizard confirms two pending items to install. 

 

Note: Sage Advisor Update is a new auto update application which allows you to apply 
future Product and Legislative Updates automatically from within Sage Abra Suite. Read the 
Sage Abra Suite v9.2 Release Notes for more information.  

 Select Install to open the Server Installation Welcome page. 

 

 Click Next to begin the server installation. When the License Agreement dialog box opens, read or 
print the License Agreement, select I accept the terms in the license agreement, and click Next. 
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 Enter your Customer Information and click Next. 

 In the Destination Folder dialog box, click Next to install Sage Abra Suite Server in the default folder. 
Otherwise, click Change and select a different folder. 

Note: The following figure shows the default destination folder for Windows XP and 
Windows Server 2003. The default destination folder for Windows Server 2008, Windows 
Vista, and Windows 7 is C:\ProgramData\Sage\AbraSuite. 
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 Wait while the InstallShield Wizard installs Sage Abra Suite Service, click Finish when complete. 

 

Step 2 - Install the Clients 

Note: If you are using Terminal Services in Windows Server 2008 or Windows Server 2003, each 
person who will be running the Sage Abra Suite application must run the client installation. 

For each client machine that accesses Sage Abra Suite, follow the steps below. If you will run Sage 
Abra Suite on the server machine you must also install a client on that server machine. Additionally, 
client installs only need to be done for the first install of a v9.2 client. When a new version is installed 
on the server, the clients will automatically update from the server.  

1. For each client machine, verify that there are no instances of a previous version of a Sage Abra 
Suite server or client installation. You can use the Add or Remove Programs control panel 
function to verify this.  

 Go to the shared folder on the server (either by using a UNC path or by creating a mapped drive) and 
from the Client folder, double-click setup.exe. If you are installing a client on the server machine, you 
can start the client installation using the shortcut Sage Abra Suite Client Install that was placed on 
the desktop during the server installation. 
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The client installation begins and searches for the required components on your machine. 

 

Note: The first time the client is installed on each client machine, administrative rights are 
necessary to install these components and a dialog box asks for an administrator user account 
and password. 

 Click Install to start installing the required components. When component installation is complete, 
you may be asked to restart your computer. If this is the case, restart immediately (not later). 

 When your computer restart is complete, the client install will automatically continue. Note that the 
time it takes for the client install to start again depends on machine configuration and speed. If the 
client install does not continue after a significant amount of time and you have verified that your 
computer restart is complete, you can manually restart the client installation (go to the shared folder 
on the server and, from the Client folder, double-click setup.exe).The Application Install dialog box 
appears asking for final confirmation to install the client. 
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 Click Install to install the Abra Suite Client. The Installing Progress dialog box appears during 
installation. 

 

 When client installation is complete, the following dialog box appears. Note that this dialog box 
appears only for the first client that is installed. That is, when subsequent clients are installed, this 
message does not appear and you are taken directly to the logon page shown in the next step. 

 

 Click OK to update files and open the logon page for Sage Abra Suite. 
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Note: The Use Windows Logon check box enables you to log on with your Windows user 
account. However, this logon method cannot be used until the proper user security 
authentication has been set for the user logging on. 

 Enter your user name and password, and select Live Data or Sample Data and click Logon to open 
Abra Suite. 

If Abra Link is installed, you can open it directly from the logon page. Select Abra Link from the 
drop-down list and click Logon to open the Abra Link logon page. 

If you obtained a new serial number and installation code to add a new module, option, or link to 
your existing Sage Abra Suite system, you can now register from within Sage Abra Suite. Refer to 
page 35 for registration instructions. Otherwise, continue with the steps below. 
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Upgrade from v9.0 to v9.2 
Tip:  As a maintenance precaution, we recommend you do the following prior to installing your 
upgrade to version 9.2. 

• At the Logon Page, press Ctrl +U to update the database structures. 

• After the update database structures process completes, at the Logon page, press Ctrl + R to 
reform the indexes. 

 

This section steps you through upgrading your Sage Abra Suite v9.0 to v9.2. To familiarize yourself with 
this process, be sure to read through all the steps before you start the upgrade. 

Important!  

Before beginning the upgrade from Sage Abra Suite v9.0 to either v9.1 or v9.2, it is imperative that you 
uninstall your v9.0 clients. 

Upgrading Live and Sample data 

The upgrade process always overwrites existing Sample data with new Sample data. For subsequent 
upgrades, if you want to preserve your Sample data you will need to do an external backup before 
performing an upgrade and restore it after the upgrade. Live data is never overwritten on an 
upgrade. 

Installation requires installing server and client 

There are two required steps in the install/upgrade process. You must first install the Sage Abra Suite 
(data) server and then install the Sage Abra Suite clients.  

If you are using Windows Terminal Services 

If you are using Terminal Services in Windows Server 2008 or Windows Server 2003, after the Sage 
Abra Suite data server is installed on the terminal server, each person who will be running the Abra 
Suite application must run the client installation. 

If you are using Windows Server 2008 

If your server is Windows Server 2008, you must reset the View properties on the C drive so that you 
can see the \ProgramData folder where the program files will reside after the upgrade. Open 
Windows Explorer and do the following: 
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1. Go to Organize > Folder and Search Options 

2. Click the View tab. 

3. Select the Show hidden files and folders button and click OK. 

Upgrade to Sage Abra Suite v9.2 

Step 1 - Install the Server 

1. Uninstall all Abra Suite v9.0 clients. That is, for each client, go to Add/Remove Programs and 
remove the program Sage Abra Suite. 

 At the server machine, open the Sage Abra Suite installation package. Browse with Windows 
Explorer to the installation package folder, and then double-click setup.exe. 
 

 The InstallShield Wizard confirms two pending items to install. 

 

Note: Sage Advisor Update is a new auto update application which allows you to apply 
Product and Legislative Updates automatically from within Sage Abra Suite. Read the Sage 
Abra Suite v9.2 Release Notes for more information.  
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 Select Install to open the Server Installation Welcome page. 
 

 

 

 Click Next to begin the server installation. When the License Agreement dialog box opens, read or 
print the License Agreement, select I accept the terms in the license agreement, and click Next. 

 Enter your Customer Information and click Next. 

 In the Destination Folder dialog box, click Next to install Sage Abra Suite Server in the default folder. 
Otherwise, click Change and select a different folder. 

Note: The following figure shows the default destination folder for Windows XP and 
Windows Server 2003. The default destination folder for Windows Server 2008, Windows 
Vista, and Windows 7 is C:\ProgramData\Sage\AbraSuite. 
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 Click Next to move to the Ready to Install the Program dialog box. 

 

 You can review your settings by clicking Back through the previous screens. When you are sure your 
settings are correct, click Install. The progress bar appears during the installation. 



Upgrade to Sage Abra Suite v9.2 

Installation and Setup Guide   25 

 

 When you upgrade from an older version of Sage Abra Suite, the prompt to uninstall the older 
version of Sage Abra Suite appears. 

 Click Yes. The Preparing Setup dialog box opens to prepare the uninstall process. 

 The Abra Suite Setup dialog box opens next. 

 

 Click Next to open the Add/Remove Components dialog box which provides the ability to uninstall 
the older version. 

 Select Uninstall and click Next. The Confirm Uninstall dialog box opens for confirmation. 
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Note:  It is important to note that the contents of the Data folder have already been migrated 
to the new Data folder location. This means that when you proceed to uninstall, you will not 
lose your data. 

 Click Yes to proceed. 

 When uninstall is complete, the following page appears. Click Finish to complete the uninstall. 

 

 When the server installation and uninstall is complete, the following page appears. Click Finish. 

 

 From Windows Explorer, go to the destination folder where you installed the server: 

• C:\Documents and Settings\All Users\Sage\AbraSuite if you are using Windows XP or 
Windows Server 2003 
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• C:\ProgramData\Sage\AbraSuite if you are using Windows Server 2008, Windows Vista, or 
Windows 7 

 Right-click the AbraSuite folder and select Sharing and Security to open the Abra Suite Properties 
dialog box. 

 Click the Security tab and set the following permissions for each security group and/or user who will 
be installing the client and using Sage Abra Suite v9.2. Be advised that users who just need access to 
the data for reporting purposes need these same permissions. 

• Modify 

• Read & Execute 

• List Folder contents 

• Read 

• Write 

 Click the Advanced button, and for each permission entry, select the check box shown below so that 
the permissions are propagated all the way down to each folder and file inside the AbraSuite folder.  

 

 Click the Sharing tab and share the folder. Set the permissions for users who access this folder over 
the network on the shared folder to Full Control. (Right-click the AbraSuite folder, select Properties, 
select the Sharing tab, click Permissions, then set Full Control for the appropriate groups or users.) 

Note: Make sure that the folder’s Share Name does not contain a space. For example, in this 
figure, the default share name AbraSuite does not contain a space.  
 

 

Step 2 - Install the Clients 

Note: If you are using Terminal Services in Windows Server 2008 or Windows Server 2003, each 
person who will be running the Sage Abra Suite application must run the client installation. 

For each client machine that accesses Sage Abra Suite, follow the steps below. If you will run Sage 
Abra Suite on the server machine you must also install a client on that server machine. Additionally, 
client installs only need to be done for the first install of a v9.2 client. When a new version is installed 
on the server, the clients will automatically update from the server.  
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2. For each client machine, verify that there are no instances of a previous version of a Sage Abra 
Suite server or client installation. You can use the Add or Remove Programs control panel 
function to verify this.  

 Go to the shared folder on the server (either by using a UNC path or by creating a mapped drive) and 
from the Client folder, double-click setup.exe. If you are installing a client on the server machine, you 
can start the client installation using the shortcut Sage Abra Suite Client Install that was placed on 
the desktop during the server installation. 
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The client installation begins and searches for the required components on your machine. 

 

Note: The first time the client is installed on each client machine, administrative rights are 
necessary to install these components and a dialog box asks for an administrator user account 
and password. 

 Click Install to start installing the required components. When component installation is complete, 
you may be asked to restart your computer. If this is the case, restart immediately (not later). 

 When your computer restart is complete, the client install will automatically continue. Note that the 
time it takes for the client install to start again depends on machine configuration and speed. If the 
client install does not continue after a significant amount of time and you have verified that your 
computer restart is complete, you can manually restart the client installation (go to the shared folder 
on the server and, from the Client folder, double-click setup.exe).The Application Install dialog box 
appears asking for final confirmation to install the client. 
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 Click Install to install the Abra Suite Client. The Installing Progress dialog box appears during 
installation. 

 

 When client installation is complete, the following dialog box appears. Note that this dialog box 
appears only for the first client that is installed. That is, when subsequent clients are installed, this 
message does not appear and you are taken directly to the logon page shown in the next step. 

 

 Click OK to update files and open the logon page for Sage Abra Suite. 
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Note: The Use Windows Logon check box enables you to log on with your Windows user 
account. However, this logon method cannot be used until the proper user security 
authentication has been set for the user logging on. 

 Enter your user name and password, and select Live Data or Sample Data and click Logon to open 
Sage Abra Suite. 

If Abra Link is installed, you can open it directly from the logon page. Select Abra Link from the 
drop-down list and click Logon to open the Abra Link logon page. 

If you obtained a new serial number and installation code to add a new module, option, or link to 
your existing Sage Abra Suite system, you can now register from within Sage Abra Suite. Refer to 
page 35 for registration instructions. Otherwise, continue with the steps below. 
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Sage Abra Suite Server 
Processor Intel XEON 2.4GHz or higher, specifically: 

• Intel XEON 3.0 GHz for  >500 but <1000 employees 

• Dual Intel XEON IV 3.0 GHz for  >1000 but <3000 employees 

• Quad Intel XEON IV 3.0 GHz for  >3000 employees 

Operating System • Windows Server 20ƕƝȮɯƖƔƕƚȮɯƖƔƕƖɯ1ƖȮɯƖƔƕƖ 

• Windows Server 2008 R2ȮɯƖƔƔƜ 

Notes:  
• Both 32 and 64-bit versions of these operating systems are 

supported. 

• Terminal Services are supported (Terminal Server 200Ɯɯ1Ɩ, 
Terminal Server 2ƔƕƖȺ 

Database Visual FoxPro v9.0 
This is the embedded database installed with Sage Abra Suite. 

Software Sage Abra Suite v9.2 
Netware is not supported. 

RAM 4 GB ɯÖÙɯÏÐÎÏÌÙ
Hard Drive 2 GB for the first 1000 employees 

Additional 1 GB for each additional 1000 employees  
Monitor SVGA 1024x768 resolution or higher  

kkubick
Typewritten Text
See Knowledgebase article 47304 for more information.

https://support.na.sage.com/selfservice/viewdocument.do?noCount=true&externalId=47304
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Sage Abra Suite Client 
Computer/Processor Intel Pentium IV or higher 
Operating System • Windows 10 (Version 1809) 

• Windows 8, 8.1 

• Windows 7 

RAM 4 GB or higher 

Hard Drive 2 GB or higher 
Monitor SVGA (1024 x 768) resolution or higher 
Graphics Program MS Paint 9 or higher (required for display of logos) 

Printers 

Sage Abra Suite supports all HP 3 or higher compatible laser printers. 

When the printer driver provides the option to select fonts, try to deselect the “Print True Type as 
Graphics” option. If the font looks odd, make sure the proper True Type fonts are loaded: open the 
Printers option in the Windows Control Panel, select the printer, click File, click Properties, and then 
select the Fonts tab. Generally, the most frequently used font is an Arial True Type font that you can 
load from the Windows installation disk (refer to your Windows documentation for loading printer 
drivers and fonts). 

To insure the fonts are printing in the correct proportion, refer to your Windows documentation to 
enable or download True Type fonts. Also, set your printer to print at no more than 300 dpi. 
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Appendix 
This appendix contains information on the following: 

• How to re-register a new module, option, or link 

• How to uninstall the product 

• How to change servers 

• The new and improved product installation 

How to re-register a new module, option, or link 
If you have an existing Sage Abra Suite system and want to add another module, option, or link/interface 
application, simply re-register Sage Abra Suite. 

First obtain a serial number and installation code for the new items you are adding to your system. You 
can obtain this information by calling Sage Employer Solutions Customer Service. 

 Launch Sage Abra Suite. 

 Select Register Abra Suite from the Help menu. 
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 The Register Sage Abra Suite dialog box appears. 

 

This dialog box shows your current serial number and installation code. If you are re-registering 
to add another module, option, or link, enter your new serial number and installation code. If you 
want to add a link or interface application, select the associated check box. 

 Click OK to complete the registration, update your system, and return to your Sage Abra Suite 
Desktop. The Main Menu and Navigation Pane will reflect the new options and modules you 
registered. 

If you added link or interface applications, they are accessible from the Quick Launch Toolbar. 

 

 Review your user and group security and make any necessary changes for the new products or 
options you installed to keep your system secure. 

 If you have previously applied any patches or legislative payroll (tax) updates, you must re-apply 
them after installing the new items. 
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How to uninstall Sage Abra Suite v9.2 
During Sage Abra Suite installation, there are three separate elements installed. They will appear in the 
Add or Remove Programs list as: 

 

• Sage Abra Suite is the client and resides on the client machine. 

• Sage Abra Suite Components are the required files, libraries, and drivers that reside on the client 
machine. The figure below appears during client installation if the required components are not 
found on the client machine. 

 

• Sage Abra Suite Server is the data server and resides on the server machine. 

To Uninstall Sage Abra Suite v9.2 

Go to Control Panel > Add or Remove Programs and remove each element separately in the same 
order as they are listed above: 

1. Remove Client 

2. Remove Components 

3. Remove Server 
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How to change servers after v9.2 has been installed 
If you need to change servers after the application has been installed, follow these steps: 

 On the server, do an external backup of your data. 

 Using Add or Remove Programs, uninstall all clients. 

 Using Add or Remove Programs, uninstall the server. 

 Re-install v9.2 on the new server. 

 Restore the data to the new server. 

 Re-install all clients. 

Learn about the new product installation 
Beginning with version 9.0, the product installation for Sage Abra Suite was completely rewritten to 
leverage new technologies in order to simplify the install process and to provide seamless support for all 
versions of Microsoft Windows. By using the latest Windows Installer technologies as well as Microsoft’s 
ClickOnce deployment technology, the new install inherits some very useful capabilities including the 
following. 

• Shared data files are no longer stored in the Program Files folder by default. Instead, they are 
stored in C:\ProgramData\Sage\AbraSuite (on Windows Server 2008, Vista, and Windows 7) or 
C:\Documents and Settings\All Users\Sage\AbraSuite (on Windows XP and Windows Server 
2003). 

• The AbraWin.ini file is now stored on the server so that all Sage Abra clients use the same set of 
shared data. 

• The server install now only installs the shared data files and the Sage Abra client install. If you 
run the application on the server, you must also install the client on the server. 

• When the client is launched, it automatically checks for application updates stored on the server. 
If new updates are detected, they are copied down to the client when each client is started for the 
first time after the update has been applied. 

• The registration process has been simplified so that when you purchase a new module, you enter 
the new install code from inside the application (from the Menu, select Help > Register Sage 
Abra Suite), instead of re-running the install. 

• For security purposes, the server installation does not set up permissions to the Sage Abra Suite 
data. This means that after installation, permissions to the AbraSuite folder must be explicitly 
configured before you can run Sage Abra Suite or access the data in another capacity (such as 
creating reports in SAP Crystal Reports). 
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• User Account Control (UAC) is now supported. To achieve this, each user account that accesses a 
workstation must install the Sage Abra client separately so that the application is now stored 
under each user’s profile. As a result, the application folder is concealed and very difficult to 
locate. The name of the folder changes whenever updates are applied. Business partners should 
take note that if an application depends on finding the Sage Abra program files, it should be 
altered or redesigned to remove this dependency. 

• Only one version of Sage Abra Suite can be supported per client machine. If you are upgrading 
from a previous version and are currently running a side-by-side installation, please contact 
Customer Support for assistance before you begin the installation. 


	Introduction
	Support and Documentation
	Before You Begin
	Install Sage Abra Suite
	Step 1 - Install the Server
	Step 2 - Install the Clients

	Read the following before you begin the upgrade
	Upgrading Live and Sample data
	Installation requires installing server and client
	If you are using Windows Terminal Services

	Upgrade to Sage Abra Suite v9.2
	Step 1 - Install the Server
	Step 2 - Install the Clients
	Upgrading Live and Sample data
	Installation requires installing server and client
	If you are using Windows Terminal Services
	If you are using Windows Server 2008

	Upgrade to Sage Abra Suite v9.2
	Step 1 - Install the Server
	Step 2 - Install the Clients

	Sage Abra Suite Server
	Sage Abra Suite Client
	Printers

	How to re-register a new module, option, or link
	How to uninstall Sage Abra Suite v9.2
	To Uninstall Sage Abra Suite v9.2

	How to change servers after v9.2 has been installed
	Learn about the new product installation



